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Introduction
Workshare Compare is a document comparison tool designed to make the process of editing and revising 
documents as fast and efficient as possible. Workshare Compare enables you to compare documents – the 
original document and the modified document – and produce a comparison (Redline) document, enabling you to 
instantly see any differences between them.

In one view, you can see both the original documents and the comparison document. You can compare a 
document against another single document or against multiple documents and see the Redline document for 
each comparison in a different tab.

You can compare Microsoft Word documents (DOC/DOCX files), RTF files and PDF files. Within a Microsoft 
Word file, you can compare all content including images, tables and embedded Microsoft Excel tables.

For users who have a DMS, Workshare Compare provides access to version information stored in the DMS. 
Understanding differences between one version of a document and the next is a critical function when editing 
and reviewing documents in multi-user environments. The Workshare Compare module utilizes Workshare 
DeltaView - the market-leading and most advanced comparison engine in the market today, to perform 
comparisons accurately and seamlessly. Comparison results are displayed within Microsoft Word or in a 
separate Workshare Compare window.

Workshare Compare’s fast, accurate and reliable document comparison capabilities enable you to quickly 
compare even the most difficult and complex documents. You can review the Redline document by navigating 
between the changes. To make the review easier, you can select different rendering sets to determine how the 
changes are highlighted within the document. A statistical summary at the end of the Redline document enables 
you to precisely match the document changes.

In addition, Workshare Compare preserves the technical integrity and style of the document – preventing your 
document from becoming corrupt or inadvertently incorporating foreign formatting or style. This not only benefits 
you through higher document quality, but also through increased productivity as well as reducing stress at 
deadlines.

Alert and Compare is the ability of Workshare Compare to automatically detect that a received attachment is a 
changed version of an original document sent previously. When a user sends a document to a recipient and the 
recipient edits the document and sends it back to the user, Workshare Compare can automatically detect that 
the received attachment is a changed version of the original document. The user can then launch a comparison 
of the two documents from Microsoft Outlook and view the Redline document in Workshare Compare. 
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Workshare Compare Benefits and Features
Workshare Compare is powerful comparison software. Its key benefits include:

 Advanced Document Comparison

Compare one document against multiple modified versions or revisions within context of one another. 
Workshare Compare utilizes an industry-leading document comparison engine to excel at long and 
complex documents as well as comparing auto-numbered paragraphs, font changes and complicated 
formatting, even in tables. 

 Compare One Document to Multiple Versions

Compare more than two documents at one time including comparing Word-to-Word, PDF-to-PDF, 
Word-to-PDF and WordPerfect files. 

 Compare PDF Documents

Compare PDF documents. The differences between two versions of a PDF document are automatically 
highlighted, including text and images, so you can quickly and easily identify what has changed. 

 Comparison Speed

Run a document comparison that is 8x-10x faster than the original DeltaView comparison engine.

 Alert and Compare - Redlines from Outlook

Generate a Redline document from Microsoft Outlook. Alert and Compare is the ability of Workshare 
Compare to automatically detect that a received attachment is a changed version of an original 
document sent previously. When a user sends a document to a recipient and the recipient edits the 
document and sends it back to the user, Workshare Compare can automatically detect that the 
received attachment is a changed version of the original document. The user can then launch a 
comparison of the two documents from Microsoft Outlook and view the Redline document in 
Workshare Compare.

 Multiple Comparison Interfaces

Compare email attachments directly from your email application, utilize the standalone document 
comparison tool from the desktop without launching Microsoft Word, or work within Microsoft Word to 
compare documents without having to learn a new software application. 

 Unicode Compliance

Complete support for Unicode language documents and operating systems. 

 Extend Your Document Management System

Leverage Workshare Compare with your existing document management system. For example, 
Workshare Compare provides a list of the DMS versions of a document, enabling the comparison of 
document versions.

http://www.workshare.com/products/wsdeltaview/
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What’s New in Workshare Compare 7 FP1
Workshare Compare 7 FP1 is a product quality release with improvements as well as the following new features:

 Workshare Compare - Ability to save a Redline (comparison) document as a Track Change document.

 Workshare Compare - Ability to save a Redline (comparison) document as a PDF file.

 Workshare Compare - Ability to specify a default Redline file name as well as include DMS document 
descriptions/locations in the file name.

 Workshare Configuration Manager – Administrator user can hide locked parameters so that users 
cannot see them in User Mode.

System Requirements
The certified environments for Workshare Compare are as follows:

Minimum System Requirements Intel Pentium 4 2.8GHz processor (XP) or Intel Pentium 4
3.2GHz processor (Vista/7) 

1GB RAM (XP) or 1.5GB RAM (Vista/7) 

1GB free disk space 

Recommended System Requirements Intel Core 2 DUO @ 2.2GHz 

AMD Athlon 64 X2 4400+

2GB RAM 

2GB free disk space 

Operating System:

 Microsoft Windows XP SP3

 Microsoft Windows Vista SP2 (32 bit and 64 bit) - UAC disabled 

 Microsoft Windows 7 (32 bit and 64 bit) – default UAC

 Microsoft Windows 7 SP1 (32 bit and 64 bit) – default UAC

Citrix:

The following Citrix environments are supported:

 Citrix Presentation Server 4.5

 Citrix XenDesktop 5

 Citrix XenDesktop 5.5

 Citrix XenApp 5

 Citrix XenApp 6

 Citrix XenApp 6.5
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They are supported when running on the following:

 Microsoft Windows 2003 Server (32 and 64 bit) 

 Microsoft Windows 2003 R2 Server (32 and 64 bit) 

 Microsoft Windows 2008 Server (64 bit) 

 Microsoft Windows 2008 R2 Server (64 bit) 

Note: Check with your Citrix vendor about which Windows operating system supports your version of Citrix. 

Microsoft Office System:

 Microsoft Office 2010 (32-bit)

 Microsoft Office 2010 SP1 (32-bit)

 Microsoft Office 2007 SP2

 Microsoft Office 2003 SP3

Email System:

 Microsoft Outlook 2010 (32-bit)

 Microsoft Outlook 2010 SP1 (32-bit)

 Microsoft Outlook 2007 SP2

 Microsoft Outlook 2003 SP3

 IBM Lotus Notes 8.x

Other:

 Microsoft .NET Framework 4.0

 Windows Installer (x86), version 3.1.0.0 

SharePoint:

 Microsoft Office SharePoint 2010

 Microsoft Office SharePoint Server 2007

DMS Integration:

Note: Check with your DMS vendor about which Windows operating system supports your DMS. 

 Autonomy iManage: 

 FileSite / DeskSite Client 8.2 SP2 (Patch 2a)

 FileSite / DeskSite Client 8.5 SP3 Update 1

 FileSite / DeskSite Client 8.5 SP3 Update 3

 Open Text: 

 Hummingbird DM 5.1.0.5, ODMA (SR6)

 Hummingbird DM 5.2.1 ODMA and COM (CU6) 

 Hummingbird DM 6.0.5 ODMA and COM (CU4)

 eDOCS DM 5.3 COM only (Patch 2)
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 eDOCS DM 5.3 COM only (Patch 4)

Note: Worldox integration is supplied and supported by Worldox.

Workshare will endeavor to support future service packs of certified environments.

Important Information
 Secure PDFs – Workshare Compare is unable to compare secure PDFs or convert secure PDFs to DOC 

format. Secure PDFs are PDF files with security settings configured.

 Licensing – If the product is licensed on subscription basis, one month before your subscription license 
expires, you can choose to receive a popup Expiry Notice on a daily basis. You can configure 
Workshare Compare so that the Expiry Notice is displayed/not displayed as required. For further 
information, refer to the Licensing Workshare section in the Workshare Installation Guide.

Important Installation Information
 Workshare Compare installs program files to a sub-folder within the Workshare folder named Modules.

 Install: A user is unable to install Workshare Compare if Microsoft Windows Installer 3.1 is not 
installed. This can be downloaded from the following location http://www.microsoft.com/
downloads/details.aspx?FamilyID=889482FC-5F56-4A38-B838-DE776FD4138C&displaylang=en.

 Windows Vista: For MSI installs the user must have administrative privileges for the Default Mail 
Client.

 Internet Explorer: You must ensure that your email application is set as the default mail program in 
Internet Explorer. In Internet Explorer, select Internet Options from the Tools menu. In the Programs
tab, select your email program (Microsoft Outlook) from the E-Mail dropdown list. If this is not done, 
you will not be able to send a document for review.

 Windows 7: When UAC is set to Default, running the Workshare Compare install displays the UAC 
prompt. You must approve the prompt and Workshare Compare will be installed. Running the 
Workshare Compare MSI silently will fail when UAC is set to Default because the user is not given the 
opportunity to approve the UAC prompt. Therefore for silent installs, disable UAC.

If you have installed any Alpha or Beta builds of Workshare Compare, we strongly recommend that you first 
uninstall them before installing Workshare Compare 7.
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Known Issues
The following are known issues in the Workshare Compare 7 FP1 release - for more information, please contact 
Customer Support.

TFS ID Details

2705 Editing Redline Documents - DeskSite 8.5 SP2/Windows 7/Office 2010

The Local Save and Local Open options are not available when editing Redline documents from 
Workshare Compare.

3454 Licensing with Proxy Server

It is not possible to license Workshare Professional using proxy server settings.

3800 Saving Redlines Default Format – Office 2003

When saving a Redline document to a DMS, the default format specified in the Workshare 
Configuration Manager is not remembered. The default format is always WDF.

4010 SharePoint and the Workshare Configuration Assistant

When SharePoint is set as the default document provider, a Workshare dialog asking for the paths 
to SharePoint sites is displayed while running the Workshare Configuration Assistant in Normal 
user.

4245 Fast Comparison Mode

The Fast option in the Comparison Mode dropdown list should only be available when comparing a 
DOC file against another DOC file. However, it is also available when comparing a DOCX file 
against DOC/DOCX/PDF/TXT files.

4315 Locking Configuration Options

When locking configuration options and applying to the current user, the configuration options are 
still locked for other users of the machine.

4326 Email as Track Changes

The Workshare Open PDF in Word dialog is displayed when the Email as Track Changes option is 
selected from the Workshare Compare window.

4331 SharePoint Profiling

When Workshare Compare is integrated with SharePoint and you save a Redline document into a 
location that requires profiling, the profile dialog blue title band is drawn incorrectly.

4356 User Override

Deselecting the Allow users to override option values parameter in Administrator Mode is not 
correctly disabling user abilities to modify parameters in User Mode.

4373 Workshare Compare – Autonomy iManage

When comparing documents from Autonomy iManage, the document paths displayed in the 
Modified Document dropdown list are incorrect - they point to a local temp directory instead of 
the WorkSite path.

4380 Apply Change Markers

The Apply Change marker images are not displaying correctly in the Redline document.
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TFS ID Details

4454 Workshare Compare Keyboard Shortcuts

In Workshare Compare, the Ctrl + A shortcut is shown for both the right-click Select All option 
and the Save As option. In fact it is the shortcut for the Save As option.

4458 ABBYY OCR

ABBYY OCR server settings applied as an admin user are used when comparing image-based PDFs 
as an admin user but are not used when working as a normal user.

4473 Comparing Unsaved Documents

An error is displayed when clicking Compare for an unsaved document.

4479 Alert and Compare

The configuration parameters relating to Alert and Compare (Comparison > Administration
category) are not clearly named.

4483 Alert and Compare

The Alert and Compare runtime policy is being installed during installation even though the 'Alert & 
Compare' option is disabled by default.

4558 Compare

The icons for ‘Swap’ and ‘Rendering set’ are missing on the Document Selection dialog.

4587 Alert and Compare

'Ready Redline Document Tracking' is being displayed instead of 'Attachment(s) Alert & Compare' 
on the progress bar of the 'Default' profile while sending email to an external recipient.

4603 Comparing Embedded Document

An error message is displayed when comparing (using the right-click option) two DOC files where 
one file includes an embedded document.

4618 Comparing Multiple Files

When comparing multiple files, the comparison mode and Rendering sets information may not be 
properly updated for each comparison.

4623 Save As to DMS

Saving a comparison as a new version to a DMS may fail.

4647 Workshare Compare – Keyboard Shortcuts

The keyboard shortcuts Alt+R and Alt +V are not functioning in Workshare Compare.

4698 Installation

The Workshare installation does not resume after rebooting during the install process when 
necessary.

4721 Compare from Word

If the user has moved and docked the Workshare Panel and then performs a compare within 
Microsoft Word, the comparison fails.

4722 Autonomy iManage

The right-click Workshare options are disabled for document shortcut links in Autonomy iManage.
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TFS ID Details

4875 Workshare Configuration Manager - Deployment Icon

In Administrator Mode, when clicking the padlock icon to unlock/lock a parameter the green arrow 
deployment icon is not being created.

4880 Redline Summary

The Count heading in the Statistics section of the Redline Summary is left justified instead of right 
justified.

4931 UI Issue

When opening a document from a DMS and clicking Compare, there is a space missing between 
the version number and 'of' in the Information section of the Workshare Panel.

4938 Workshare Compare – Synchronization

When a modified document includes a change to the title, selecting this change in the Change 
Summary window may cause a loss of synchronization between the Source Documents and the 
Redline document.

4984 Saving Redlines to SharePoint

Saving a Redline document to SharePoint does not use the default format specified in the 
Workshare Configuration Manager.

4996 WorkSite 9.0

The Workshare options are not present in the right-click menu in DeskSite/FileSite 9.0. 

4998 Redemption DLL

Installing Workshare Professional 7 over Workshare Professional 5.2 SR3 FP3 removes the 
Registry keys pointing to Redemption.dll (version 4.8).

5055 Upgrade - Workshare Compare

After upgrading from Workshare Compare to the latest Workshare Compare, 'Workshare 
Professional' is displayed in the Programs list in the Control Panel.

5073 Default Outlook Font

When emailing from Workshare Compare, the default Outlook font is not used.

5092 Comparing - Long File Names

After comparing documents with long file names (76 or more) and selecting to email the Redline 
document, the user cannot drag and drop the Redline document to another email.

5099 Comparing – File Formats

The Change Summary display may present changes slightly differently depending on whether DOC 
or DOCX files have been compared.

5188 Compare - Detecting Changes

Data in a Word document that is changed to column format is not detected as moved from one 
place to another in the Redline document.

5222 Compare – Table Auto Numbering

Table auto numbering changes are displayed in a Redline document as inserted/deleted rows 
rather than cell content changes.



WORKSHARE COMPARE RELEASE NOTES

11

TFS ID Details

5233 Convert to Track Change Document

When converting a Redline to a Track Change document, an extra section break and page at the 
end of the document are displayed.

5266 Compare – Windows 7 SP1 x86

An error may be displayed when clicking Compare in the Workshare Ribbon when the document 
has not been saved.

5270 ABBYY OCR Configuration

ABBYY OCR server configuration is not included in Deployment Scripts saved via the Workshare 
Configuration Manager.

5298 Table Alignment

After comparison, table alignment for insertions and deletions may be inaccurate in the saved 
Redline document.

5441 Compare from Word

When comparing within Word, the navigation keys are not working properly when images are 
present in the changes.

5480 ABBYY OCR

The 'SolidPDFUseOCR' Registry option is not working as expected while comparing image-based 
PDF documents. 

5498 Workshare Configuration Manager - WSO File

The When sending an email with attachments show parameter setting does not get saved 
when saving the configuration as a WSO (Workshare Options) file and reloading into the 
Workshare Configuration Manager. 

5509 Workshare Compare - Classic View

In Classic View of Workshare Compare the Email option is spelled incorrectly.

5518 Sending Redline Documents

A user is able to send a Redline document as a PDF file when the Allow users to change email 
attachment format parameter is NOT selected and the Default email attachment format
parameter is set to WDF.

5521 SharePoint Unicode Documents

When comparing server documents, the name of Unicode documents is not shown correctly in the 
title of the Compare window. 

5523 Emailing PDFs - Outlook 2010

The Workshare ribbon with the Compare Attachment with Workshare option is not available 
when a PDF document is sent using the File > Attach to Email option. 

5535 Saving Redline Document – Document Description

The Include document descriptions in the Redline file name parameter in the Workshare 
Configuration Manager (Integrations > General category) is not working as expected for local file 
system documents.
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TFS ID Details

5536 Saving Redline Document – Document Location

The Include document locations in the Redline file name parameter in the Workshare 
Configuration Manager (Integrations > General category) is not working as expected for local file 
system documents.

5568 Compare - Text Only Mode

The comparison is not performed when comparing a server PDF document with other documents 
in 'Text Only' mode.

5569 Customizing Quick Access Toolbar

A comparison may not perform correctly after customizing the Quick Access toolbar.

5574 Comparing Password-Protected Documents

When comparing password-protected documents, a user is prompted for passwords before the 
comparison is performed and visible instances of winwords are created and not closed even after 
entering a correct password. 

5576 Compare - Quick Access Toolbar

After adding the choice of rendering sets to the Quick Access Toolbar in Workshare Compare and 
then closing Workshare Compare, the rendering sets are not retained in the Quick Access Toolbar 
when Workshare Compare is relaunched. 

5579 Compare – PDF Options

The Convert to PDF and Convert to PDF and Email options (Home ribbon, Actions group) are 
also available in the standalone Compare application. 

5602 Saving Redline to SharePoint

An error message is displayed when overwriting existing WWB/WDF/PDF files after enabling the 
Profile New Documents option.

5619 Rendering Set – Ignore Field Codes

When selecting to ignore field codes in Comparison Options (Rendering Set Manager) and 
comparing documents with table of contents, the field codes in the TOC are still compared.

5620 Convert to Track Change Document – Cross References

When converting a comparison to a Track Changes document, cross-reference fields are not 
retained.

5623 Convert to Track Change Document – Compatibility Mode

When converting a comparison to a Track Changes document, the resulting Word document 
displays in Compatibility Mode.

5625 Convert to Track Change Document – List Numbering

When converting a comparison to a Track Changes document, the list numbering is not displayed 
as a change.

5627 Convert to Track Change Document – Tables

When converting a comparison to a Track Changes document, accepting/rejecting does not enable 
a user to shift cells, only to apply the cell contents.
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TFS ID Details

5654 Adding Server Details

Users are able to add Interwoven server details in the Workshare Configuration Manager 
Administrator Mode. 

5675 Amyuni 450 Update

The contents of the original PDF are not concatenated accurately after updating Amyuni Driver. 

5676 Rendering Sets

Rendering set options are not retained after applying and re-launching the Rendering Set Manager. 

5677 Convert to Track Change Document – Text Error

An error message 'Failed to run Act on Changes..' is displayed when selecting to Convert to Track 
Changes after saving the comparison as a PDF file. 

5680 Closing Comparisons

When the File > Close option in Workshare Compare has been disabled (Enable ‘Close’
parameter), when using the Exit button (in the File menu), the comparison is closed without 
prompting to save. 

5691 Emailing Comparison Documents

After comparing PDF and TXT files and saving the Redline document as a WDF file, emailing the 
WDF file as a comparison document to an external recipient and including the original and 
modified documents, the recipient will be unable to open the original and modified documents 
(they are corrupted) although the recipient can open the WDF file.

5692 Text Only Mode

After comparing any two supported documents in text only mode and then saving the comparison 
as a WDF file, when a user relaunches the saved comparison and changes the Comparison Mode 
from Text Only to Standard, the comparison is still shown in text only mode.

5697 Edit Rendering Set

Workshare Compare may crash when applying changes made after selecting to edit the Rendering 
set.

5701 Comparison Mode – Windows 7

Settings selected in the Workshare Compare main window are retained when opening subsequent 
comparisons except for the Comparison Mode.

5714 Convert to Track Change Document

After comparing two server documents and selecting Convert to Track Change document, the 
comparison is opened in Word with the changes shown as track changes. However, if in 
Workshare Compare, Convert to Track Change document is selected again, an error is displayed.
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Change Requests Addressed
The following Change Requests have been addressed in Workshare Compare 7 FP1 (Build 10000.3000). Please 
note that some of these issues were specific to customer environments. For more information, please contact 
Customer Support. 

TFS ID CR Number Description

4585 00157141 Uitlijn Word add-in slows down with Workshare.

4781 00160693 Redline statistics placed on first page if 'Allow Users to Override' is disabled.

4784 00160968
Comparing documents with specific field codes results in Redlines being poorly 
displayed when saved to .doc, .docx and .rtf formats.

4793 00161170 Workshare Configuration Manager (WCM) will not open successfully.

4812 00161220
Documents containing tabs instead of first line indents cause Redlines to be 
incorrectly rendered.

4870 00162368 Unable to perform request: Unexpected exception using the Workshare Ribbon.

4885 00162625 Incorrect font is displayed when editing or saving a Redline.

4910 00162992
Workshare Outlook add-in is preventing Quest Archive Manager from archiving 
emails.

4943 00163424 Document numbering incorrectly displayed after comparison.

4944 00160169
The option 'Append document IDs to the Redline filename' replaces the file name 
instead of appending.

5005 00163063 Request ability to disable and lock down Change Summary.

5051 00164191 Error Code - 30 saving redline as PDF.

5095 00164454 Running the Workshare Configuration Assistant disables Outlook integration.

5120 00161788 Ability to configure save as DMS version option through WCM user interface.

5121 00121359 Ability to remove the file names from the Input part of Redline statistics.

5123 00160629 Show Hidden Text' no longer available in Rendering Set Manager.

5124 00160628 Tooltip showing Redline document names missing in Compare.

5125 00160100
Office 2003 specific - "Home" and "Back" buttons are disabled for different options 
in Workshare Panel.

5127 00129093 Ability to save comparison as Track Changes document.

5130

00163003 
00162819 
00161909 
00155507

Ability to retain all document elements (e.g. Field Codes, Cross References, 
Attached Templates) when comparing.

5133 00161140 Ability to force lock the "Hide Options I cannot change" option.



WORKSHARE COMPARE RELEASE NOTES

15

TFS ID CR Number Description

5136
Embedded emails that have previously been used via Alert and Compare cannot be 
opened from Sent items folder.

5139
Numbering is incorrect when comparing attached documents and saving the 
Redline as a DOCX document.

5141 00156731 Documents of a certain file name length fail to compare in Standard mode.

5143 00157968
Request that the ability to change document format when sending a Redline be 
made obvious.

5147
00146349 
00161378

Documents that contain special symbol in name are not listed under 'Compare 
attachments with Workshare' option.

5148 00155136 Function cannot be performed because the object has been deleted.

5149 Load Defaults' is not working as expected when options in WCM are locked.

5151 00160742 Saving ADM file over itself from WCM appends options.

5154
Detect Changes to Images' and 'Ignore Case Changes and Ignore Text Boxes' 
options in Rendering set are not working when compared with in word.

5156 00161731
When the 2 attached documents are compared table rendering is inaccurate in the 
saved Redline.

5157 Options are not being un-deployed by clicking on the deployment icon.

5158
ADM template for Workshare in the Group Policy Management Console does not 
create the setting "IgnoredUserOverrides" for all sub categories within the WCM.

5159
ADM settings saved as registry target 'HKCU' with '32 bit Workshare on 64 bit OS' 
are not retained in x64 environments in user mode of WCM.

5160 00149342 Ability to save Redline as Word 2010 Document (*.docx).

5164 00160714 Unable to browse to sites within Virtual Directories in SharePoint.

5165 00161372 Saving custom paths to REG file via WCM not functioning correctly.

5167
Ability to display progress bar when saving files/Redlines as PDF or opening PDF in 
Word.

5168 Ignore Tables' option in Rendering set is not working when compared with in word.

5169
Instance options are being saved to the deployment script regardless of the 
deployment icon state.

5170 Admin only options are present in IgnoredUserOverrides folder.

5171
When upgrading from previous releases certain configuration options are not being 
upgraded.

5173
"Discard Changes" confirmation dialog is shown when closing WCM even though 
no changes were made.

5174 WCA Help gives reference to ini files.

5175 00161965 Failed to open a stream on a file - OnWriteComplete error.
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TFS ID CR Number Description

5180 00162437
Workshare Configuration Manager hover tooltip "Default Value" does not reflect out 
of the box Default Value.

5182 00162106 Table cell moves showing as inserted/deleted rather than moves.

5220 00128979
Ability to automatically populate Modified Document field when comparing 
Interwoven versions.

5223 00165139
Compare crashes when printing Original/Modified documents when using Redline 
only view.

5226
Compositor changes for supporting new Review module for compare service and 
catalyst.

5238 00156344 Unable to save Redline to WorkSite as application type incorrectly populated.

5242 00161385
Split Word format to 'doc and docx' for 'Default email attachment format' when 
emailing Redline.

5246 Issues related to Registry options migration after upgrading to 7.0 builds.

5259 WCM Crash is observed while loading a .wso file.

5260 Prompt users to view/find Saved redline PDF.

5463 00160709 Ability to set default Redline name to include a prefix.

Contact Info
For feedback on Workshare products, including ideas for new features and improvements, please contact us on: 
feedback@workshare.com.

For more information, please contact Workshare:

Email: sales@workshare.com

Workshare Ltd.
20 Fashion Street
London E1 6PX
UK

Workshare Inc.
208 Utah Street, Suite 350
San Francisco CA 94103
USA

Workshare Ltd.
Level 56, MLC Centre
19-29 Martin Place
Sydney 2000
Australia




